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IBM WEBSPHERE ADAPTER FOR JDBC V7.0 — LAB EXERCISE

JDBC outbound lab — Hierarchy business objects
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What this exercise is about

The objective of this lab is to provide you with an understanding of the WebSphere Adapter for JDBC and
outbound request processing.

Lab requirements
e WebSphere Integration Developer V7.0 installed
e WebSphere Process Server V7.0 test environment installed
e WebSphere Adapter for JDBC V7.0 installed

e Sample code in the directory C:\Labfiles70\JDBC (Windows) or /tmp/LabFiles70/JDBC (Linux)

What you should be able to do
At the end of this lab you should be able to:

< Install and deploy the Adapter for JIDBC and integrate it into an SCA application for use with outbound
request processing. This exercise demonstrate one scenario which is creating a multiple cardinality
business objects Hierarchy using External Service Wizard, instead of editing the parent and child
Business Objects using Business Object Editor. The ‘Keep Relationship’, ‘Ownership’ and ‘Required’
ASils can also be specified in Configuration Parameters Screen of External Service Wizard.
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Introduction

This lab introduces you to the WebSphere Adapter for JDBC and the processing of outbound requests to a
table in a database. It uses a JDBCTEST Derby database that contains a CUSTOMER table. In the lab,
you will import the JDBC Adapter into WebSphere Integration Developer and run External Service to input
connection information, create a service description, and discover objects existing in the specified
database. You will then assemble an SCA application, wiring together a stand-alone reference and the EIS
import file. To test your application, you will use the WebSphere Test Environment and Component Test,
exercising various outbound requests, such as create, delete, retrieve, and retrieveAll.

Exercise instructions

Some instructions in this lab are Windows operating-system specific. If you plan on running the lab on an
operating-system other than Windows, you will need to run the appropriate commands, and use
appropriate files (.sh or .bat) for your operating system. The directory locations are specified in the lab
instructions using symbolic references, as follows:

<LAB_NAME> JDBCOutbound
<WID_HOME> C:\Program Files\IBM\WebSphere\ID\7.0
<WPS_HOME> <WID_HOME>\runtimes\bi_v70

<JDBCADAPTER_HOME> <WID_HOME>\Resource Adapters\JDBC

<LAB_FILES> C:\Labfiles70 /tmp/Labfiles70

<TEMP> C:\temp tmp

Windows users note: When directory locations are passed as parameters to a Java™ program such as
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java
convention. For example, replace C:\LabFiles70\ with C:/LabFiles70/

Note that the previous table is relative to where you are running WebSphere Integration Developer.
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Instructions if using a remote server for testing

Note that the previous table is relative to where you are running WebSphere Integration Developer. The
following table is related to where you are running the remote test environment:

<SERVER_NAME> serverl sssr011

<WAS_HOME> C:\Program letc/sscell/AppServer
Files\IBM\WebSphere\AppServer

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com

<SOAP_PORT> 8880 8880

<TELNET_PORT> N/A 1023

<PROFILE_NAME> AppSrvol default

<USERID> N/A ssadmin

<PASSWORD> N/A frlday

Instructions for using a remote testing environment, such as z/0OS, AIX® or Solaris, can be found at the end of
this document. Go to the section “Task: Adding remote server to the WebSphere Integration Developer

test environment”.
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Part 1: Create the JDBCTEST database using Derby

In this part you will create the JDBCTEST database along with the CUSTOMER and ADDRESS table for
user data.

If you choose to run the JDBCInbound lab first, then you only need to create additional table, ADDRESS
for this exercise. If you choose to run JDBCOutbound User Defined SQL lab first, then you can skip this
part and proceed to Part 2.

If you are using a remote testing environment on z/OS,it is recommended to create the Derby
databases on your Windows machine and then FTP the data files to the z/OS environment. Be sure to
upload the files in the /log and /seg0 directories in binary format, and the “service.properties” file in ASCII
format. You used a directory on the host called /tmp/LabFiles70/DerbyDB. Also be sure to use the
CHMOD command to change all the files to 777.

1. Start Derby ij command

Note: The Derby embedded driver that is being used in the lab, supports a connection from only one JVM
at a time. You can have either the server running and connected to the JDBCTEST database, or the
vendor GUI tool connected to the JDBCTEST database; but not both at the same time.

___a. Open a command prompt window, navigate to this subdirectory, and run Derby’s interactive
JDBC scripting tool.

<WPS_HOME>\derby\bin\embedded>ijj

2. Using the command line, create the JDBCTEST database if it does not already exist. If you have
already completed the JDBCOutbound lab, the database, tables, and triggers are the same.

___a. Type in this script to create JDBC database as user ‘Wbidemo’ and password ‘Wbil5Demol’ in
the Console view.

connect ‘jdbc:derby:databases\JDBCTEST ;create=true;user=Wbidemo;password=Whbil5Demol’;

Cos I BMSFAGHUI DY _WTEsruntimessbi_v?sderbysbinsembedded>ij
ij version 18.3

ij» connect ' jdbc:derby:databazes~JDBCTEST ;create=true;user=UBIdemo:password=WEBI
4ﬁ£em01’;

i

3. Enter SQL to create two tables: CUSTOMER and ADDRESS tables for user data.

NOTE: For your convenience, these SQL code snippets can be found in
<LAB_FILES>\JDBC\snippets\CUSTOMERSQL.txt

___a. Paste this script into the command window:
CREATE TABLE CUSTOMER

(
pkey VARCHAR(10) NOT NULL PRIMARY KEY,
LName VARCHAR(20),
FName VARCHAR(20),
ccode VARCHAR(10)
R
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SNIBMSYAGHNUHI DY _UTE~runtimessbi_vderhysbhinsembedded>ij

ij version 18.3

ij» connect *Jjdbc:derby:databases~JDBCTEST ;create=true;user=URIdemo;password=WEI
LDemol’ ;

ij»*» CREATE TABLE CUSTOMER

o

pkey UARCHARCiA> NOT WULL PRIMARY KEY.
LMame UARCHARC2A.
FMame UARCHARC{2A8>.

ccode URARCHARC1@>

B rows inserted/updated/deleted
)

NOTE: For your convenience, these SQL code snippets can be found in
<LAB_FILES>\JDBC\snippets\ADDRESSSQL.txt

___b. Paste this script into the command window:
ij» CREATE TABLE ADDRESS

L8
addrid URRCHAR<18> NOT WULL PRIMARY KEY.
custid UARCHARC18>,

city UARCHARCZG: .
zipcode VARCHARC18>

4. Disconnect and exit the ij command window

ij* disconnect;
ij> exit;

sSIBHS?AGHSUID? _UTEsruntimesshi v derhyshinsembedded >

Note: You must exit the ij command window, before starting the server as the Derby “embedded”
database driver used in this lab allows for only one JVM connection at a time.

Remember that if you are using a remote test environment for this lab, you need to FTP the Derby
database files to the remote system, as explained at the beginning of this section.
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Part 2: Set up the development environment

In this part, you will start WebSphere Integration Developer, using a new workspace, import RAR file and
set up the WebSphere Process Server to be used as the WebSphere Test Environment (WTE).

1. Start WebSphere Integration Developer V7.0 with a new workspace.

___a. From the start menu select Start > Programs - IBM WebSphere Integration Developer 2
IBM WebSphere Integration Developer 7.0 = IBM WebSphere Integration Developer V7.0

___b. When prompted enter <LAB_FILES>\JDBC\outbound-hierarchy\ for your workspace and click
OK

3 Workspace Launcher

Select a workspace

IBM WebSphere Integration Developer 7.0 stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Warkspace: ; CIBMWWIDProjectsworkspace \ FOVIDBC \Outhound\Hierarchy !:i | Browse...

¢ Copy Settings

@

(8].4 ] [ Cancel

___¢. When WebSphere Integration Developer V7.0 opens, close the Getting Started page

@ Business Integration - Getting Started - IBM WebSphere Integration Developer 7.0 - IBM WebSphere Integration Developer 7.0 - C:...

Filew Edit Mavigate Search Project Window Help

S B E BB ﬁ’;@ﬁuﬂnesslnte...|
J.E_: Business Integrati %‘\\\_E Ij\i!(ﬂ Getting Started - IEM WebSphere Integration Developer 7.0 3@-.“ - = E'

g #eelas” i)
= o~
| Integration Solutions MNew... O | ! /}I !
' || % Welcome to WebSphere Integration Developer

[z integration solution

E‘g Task Flows LB

5&5 Resaurces
Interactive flows teach concepts and show you Discover new and improved features and learn
v to perform tasks. how to migrate your 2pplications,

& What's new

® | earn the Basic Concepts
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Part 3: Create the JDBC Outbound application

In this part you will run External Service to discover objects and create the necessary SCA artifacts, and
assemble the adapter into an SCA application.

NOTE: If you are using a remote test environment on z/OS, you will first need to enable your Derby
database for network access using these steps:

On the host, login to the system using telnet.

In order to allow connections to the network server, you need to edit the
/<WPS_HOME>/cloudscape/db2j.properties file. Delete the ‘#' (pound sign) to uncomment this line:

db2j .drda.host=0.0.0.0

Navigate to /I<WPS_HOME>/derby/bin/networkServer
Issue the command ./startNetworkServer.sh

Keep this telnet window open during the next few steps; this window will show when a connection has
been successfully made from WebSphere Integration Developer to the database server.

*NOTE that there are security concerns with enabling the network server for Derby in this manner. Read
the information in the db2j.properties file regarding these security concerns to determine if your installation
will allow for the use of the network server for Derby. If not, you can continue doing the lab using the
integrated test client in WebSphere Integration Developer instead of your remote test environment.

1. Inthe Business Integration Perspective, run the External Service wizard. A Business Integration
project is created for you during this process.

__a. From the top Menu bar, select Window > Open Perspective > Other ... > Business
Integration (default) click OK

2. From within the Business Integration Perspective, select File > New > External Service. This
opens an External Service wizard that helps you obtain a service which establishes connectivity with
other systems. The wizard provides four connectivity options — Adapters, Java, Registers, and
Messaging

___a. Expand Adapters, select JDBC, and click Next
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B New External Service

Select the Service Type or Registry -
Select the type of service to create or registry to browse, { 3

Filter: |type _ﬁ_I_tnj:r text

Available types:

| B @ Adapters "I:
i .IZIEI-'.I}I o { B |
-1 E-mail =
# [ FatFie |
- ftp FTP L)
AT IS

i EE! 15eries

[well

3. Highlight IBM WebSphere Adapter for JDBC (IBM: 7.0.0.0) and click Next

4. Adapter Import screen:

In this step, you will import a connector resource adapter archive from the file system into your WebSphere
Integration Developer workspace. The adapter RAR file already exists under <JDBCADAPTER_HOME>.

__a. The default Connector file is selected which is shipped along with WebSphere Integration
Developer

___b. Accept the default name for Connector project, CWYBC_JDBC. You can change it to any other
name, but for this lab, you can leave the default name.

___c. For Target server, ensure that WebSphere Process Server V7.0 is selected
{3 New External Service = %]
Import a RAR File ——,

Import a resource adapter archive (RAR) from the file system to create a @ I
connector project for the adapter. =

Archive file; CIBMVOGMYWID T \ResourceAdapters \JDEC_7.0.0.0

VCWYBC _JDBC.rar
Connector project: = | CWYBC_JDBC| .
Target runtime enviroment: :WEbSDhEFE Process Server v7.0

5. Add any external dependencies your adapter has to the imported project. These are dependencies
that the adapter can have on the JDBC applications (adapter—specific).
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___a. Click Add and browse to the location of c:\<WPS_HOME>\derby\lib and select the derby.jar. If
you are using a remote test environment on z/OS, you will also need to select db2jcc.jar and
db2jcc.license.jar. The db2jcc.jar file is sometimes located in directory \derby\lib\otherJars.

9 Mew External Service

Locate the Required Files and Libraries (T,

Connector projects reguire system-specific ibraries and JAR, files.

When deploying the application to a stand-alone server, these files must be configured on the
gerver, More o -

Specify the location of the IDBC driver 1AR files required to access the database server. IDBC
driver JaR files are shipped with the database installation. If vou do not have a local database
installation, you can download these files from the database vendor's Web site.

JDBC driver JAR. files:

___b. Click Next
6. Select the type of processing the adapter will perform at runtime

___a. Select Outbound and click Next

&3 New External Service = x|

Select the Processing Direction g&r}—
Select the direction of adapter processing at run time. ;

) Inbound

Inbound processing passes data from the adapter to vour service export,

it

@) < Back ]Lt_JExt:b || ik
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7. Complete the Connection Configuration for Discovery Agent Configuration panel to connect to the
JDBCTEST database and discover the available services. To connect to the database, these
information are necessary: username, password, database URL and JDBC driver class. Check the
driver manual for the appropriate values for driver URL and driver class.

___a. From the left panel, expand Generic JDBC and select 1.0
___b. From the right panel, enter/select these following values
1) JDBC Diriver type: Other
2) JDBC Driver classname: org.apache.derby.jdbc.EmbeddedDriver
3) Database URL: jdbc:derby:<WPS_HOME>derby\databases\JDBCTEST

__c. Enter valid user ID and password values, for example

Username: Wbidemo
Password: Wbil5Demol

NOTE If you are using a remote test environment, use a valid user ID and password for the remote
system and enter these values for DatabaseURL and JdbcDriverClass

DatabaseURL: jdbc:db2j:<WPS_HOME>\runtimes\bi_v70\derby\databases\JDBCTEST
JdbcDriverClass: com.ibm.db2j.jdbc.DB2jDriver

If using a remote test environment on z/OS use these values
DatabaseURL: jdbc:db2j:net://<HOST_NAME>:1527//<remote_derbydb_path>/JDBCTEST
JdbcDriverClass: COM.ibm.db20s390.sqlj.jdbc.DB2SQLJDriver
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G} Wew External Service :

Specify the Discovery Properties = %

Connecton properties -

Database system connection information - =

.-:::l& | = Preperbes: —
i = ea—i] — — |t |
oo yeD [ JIDBC driver type: | Other o
: m2veg Database; .

- DBZUDE iSeries | - .

& ¢ DB2UDB zSeries Gt

[# < QOrace PorERmDer;

._F: ) SOL S =3 _'. =

£ < E.rver JDBC driver dass name: = | org.apache.derby.jdbc.EmbeddedDi

% Informix = : o .

=4 Generic JOBC | ||| Database URL: * _jdbl::l:lEFb‘f:C:'I,IBM'I,DE‘SEIUE",dEFb‘r"-,d:'
~og e % Additional I0BC driver >

User name: % I_'n.f'.n'bidemn I

F'aSSWDFd: = I-:xﬂx:xﬂx:&

Prefix for business object names:

[ change the logging properties for the wizard

|Change the logging properties for the wizardL

i,

< Back ][ Mext = ] Finish

__C. Click Next
8. Complete the Find and Discover Enterprise Services panel
___a. Click the Edit Query button
___b. Check option Prompt for additional configuration settings when adding business object

___c. Click OK.
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€N New External Service

Specify the Query Properties P

Specify the pattern for the schema name filter (for example, ADMIN® or SCOT?)

Schema name or pattern:

Supported database object types:
| Tables | “&dd
Views
Stored Procedures namole
Synonyms - Mick Names

[ ImMap IDBC Date/Time Timestamp types to dateftime /dateTime.
Prompt for additional configuration settings when adding business object
[]create a query business ohject to build user-defined Select statements

ierhstatements are e the Cuery Statementsnode of thediscoversd

oA g

[ ]create a batch SQL business object to build user-defined insert, update, and delete statements,
ramber otbatehistl brsiness objects bo create: I ]

Tk

Batch Al statements arelisted Under the Batch S0l Statements node of the discoveted objects

f?} [ Ok ] [ Cancel

___d. Click Run Query button. A connection is made to the Derby JDBCTEST database and a
selection of Meta data objects is presented in a tree-like structure.

3
___e. Expand the schema named WBIDEMO, expand Tables, highlight CUSTOMER, click the
button.
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__f. It opens up a window for setting the Configuration Parameters for the CUSTOMER table. All the

controls, like Choose Parent, for Hierarchy BO Generation are not available as no object is
imported yet. Click OK button to add CUSTOMER table.

@' ow External Service

Find Objects in the Entg
@ Mo discovered objectis sel

EB Mew External Service

Specify the Configuration Properties for "CUSTOR

i)
Query: | SchemaFilterLabel=n

-

Select status column name and status value for logical delete
Mame of the column used [ [ |
ta perform logical deletes: B

Discovered objects:

An-operation can be performed by a stored procedure. You canruna

stored procedure to perform the operation ar to do custom processing
before or after processing.

To use 3 stored procedure, add it to the list and then configure it.:

Add...
(@) ADDRESS s
@ customer | 2 ok || cancel

___ 0. Select Address table and click the

button.

___h. 1t opens up a window for setting the Configuration Parameters for the ADDRESS table where
you can select Parent table and map parent-child attributes.

___i. In the Configuration Parameters screen for Address, select these following values
1) Choose CUSTOMER (WBIDEMO) as the Parent table for ADDRESS from the list box.

2) This particular scenario creates business object with multiple cardinality between
CUSTOMER and ADDRESS, therefore do not check Single Cardinality check box.

3) To Map Parent Child Attributes, choose PKEY of CUSTOMER for CUSTID from the drop-
down list.
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4) Check Parent object owns child object, Preserve ADDRESS when parent is updated,
ADDRESS required for operations on parent check boxes to specify the respective
ASls.

5) Click Ok

@ External Service

Configuration Parameters for "ADDRESS'

Set the configuration parameters, then press OK, . 1

Select status column name and status value for logical delete

Name of the column used
to perform logical deletes:

Choose parent table from the list for the selected child
Choose parent table : CUSTOMER (WEIDEMO) v
[ single cardinality

Build a foreign key relationship by selecting a parent table column for each child column
ADDRID: MOME v

CUSTID: PKEY |~
CITY: NOME v
ZIPCODE: MOME v
Parent object owns child object (cascade delete)

Preserve ADDRESS when parent is updated

ADDRESS reguired for operations on parent

An operation can be performed by a standard SQL statement or by a stored procedure. You can run a
stored procedure to perform the operation or to do custom processing before or after processing.

To use a stored procedure, add it to the list and then configure it:
Add...

7 Ok l [ Cancel

___J- Click Next
9. Complete the Configure Objects panel
a. A new operation Exists has been added in addition to the current list of supported operation.
b. No wrapper object is required at this time.
c. Leave the default value for Namespace. Note the Operations available.

d. Note that Business Graph is optional - It will determine if you want to generate business graph or
not. If the property is checked then business graphs is generated. By default, the property is
checked.
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8 Tow Batornal Sorvice @

Specify Composite Properties

Specify properties that apply to all selected objects.

COperations for selected business objects - =
Operations for these functions will be added to the service interface.:*

Create

Update

Delete

Retrieve

Retrievesll

ApplyChanges =
| Exists el

Create and configure user-defined wrapper objects —

B

Wrapper object names:

[ Ireturn all records for Retrieveall aperation

Maximum records for Retrieveall operation: [ 100

Business object namespace: _http:;'_.f"{\"ay"ay.!b_rn.u;u:nr!'u,."x_rnIns;'!ql'odfuy'ebs?hn_arefjan,."j_u_:lpu;
Spedfy the relative folder for generated business obijects

Folder: :

Generate & business graph for each business ohject

@ <Back ][ text>

___e. Click Next
___10. Complete Publishing Object Configuration Properties
___a. Specify the security crendentials
1) Uncheck JAAS alias option and select Other to define the data source JNDI name
___b. Leave the default “With module for use by single application” option in this exercise.
___¢. Under Connection properties
1) Leave the default “Specify predefined XA Datasource”
2) Database Vendor is pre-populated with value Other (If you were using DB2, Oracle, or
MSSQLServer, you see those values instead as specific adapter processing is available

with those specific databases.)

3) Enter jdbc/Derby XA for JDBC for XA Data source JNDI name
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N Now Bxternal Service

Specify the Service Generation and Deployment Properties

e
specify properties for generating the service and running it on the server, =\ 3
Service Operations - = 5{\-5
To modify the names, or add a description to the operations to be generated in the
interface file, dick Edit Operations. AR LA

Deployment Properties - =
How do you want to specfy the security credentials?
IJsing an existing JAAS alias {recommended). — =
[ JUsing an existing JAAS alias {recommended)

& lava Authentication and Suthorzation-oetrices L 18 85T allasis fne prererred method,

126G aEhentication data ety
IJsing security properties from the managed connection factory - =
[ ]using security properties from the managed connection factory

T LA Lt et LT et e S e L DL e e
el El e RIR = b R | W e =g ) e S L ]| R et P R o L e o =

Passttas
Other - =

Other

Use if no security is required or will be handled by the EIS system, or the RAR will be deployed on the
server and security will be specified by the properties in the INDT lookup name.

The guality of service to join the transaction provides a higher degree of data integrity, espedially in the
event of a failure, To participate in a fransaction, & predefined XA DataSource or XA database connection

[+] J0in the transaction {recommendad)

s

Deploy connmector project: iWiﬁ'n module for use by single application Rl

spedfy the settings used to connect to JDBC at run time;

Connection Properties =
Database connection information: |5|:|E|:iﬁr predefined XA DataSource L -VJ

Database system connection information
Database vendar: ETHER.

%A DataSource JNDI name: = |j|:||:u:,|"Der|:n,' XA for 1DBC| |

Note: If you are using a remote test environment, the values for databaseURL and JdbcDriverClass
should match the values provided earlier during the External Service wizard, not what is pictured below.
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___d. Click Advanced button for additional properties options
1) Optional for logging and tracing

a) Enter any numeric value for Adapter ID. This property identifies the adapter
instance in log and trace files and for PMI events. The adapter ID is used with an
adapter-specific identifier, MyAdapterRA, to form the component name used by
Log and Trace Analyzer.

b) If you set the property to disguise user data as “XXX’, the adapter will replace user
data with a string of X's when writing to log and trace files. For inbound processing,
this property is retrieved from the resource adapter properties. For outbound
processing, it is retrieved from the managed connection factory properties.

= Additional connection configuration

SQL guery toverify the connection:

Query tmeout (seconds):

Return business object even when the [ false
stored procedure result setis empty:

w Lngging anu:l tan:ing

Adapter ID: | 001

[ | Disguise user data as %" in log and trace files.

b Bidi properties

- Connection retry sefttings

Maximum retries on connection failure: ]

Baipie maln mEmillisecards:

___e. Click Next
11. Complete Publishing Properties panel
___a. A Business Integration Module has not yet been created. You can define the module here also.

1) Select the New button Select the radio button “Create a module project” from new
Integration Project pop up window.

2) Enter in the name JDBCTestOutboundHier for the Module Name
3) Accept the defaults and click Finish

__b. Leave the default JIDBCOutboundIinterface for the Name
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E External Service

=]

Publishing Properties
Specify the properties for publishing.

lal

Properties for service

Module: |JDBCTestOuHJoundHier M [riew... |
hlamespace: |-'::3: 'IDBCTestOutboundHier [IDBCOutboundInterface |

|Use default namespace
Folder: | | [Browse... l
Name: * | IDBCOutboundInterface |

[ save Business Ohjects to a library
Librarys lew
Description: |

(7 Mext = Finish ] [ Cancel

__c. Click Finish

12. Verify the result as given below

2010 May, 03

- Business Int 53 5. Physical F‘.es] = O
SIEIEEIEE

Integration Solutions =

Projects =

=8 cwysc_IDBC
Eg IDBCTestOutboundHier
% %) {Assembly Disgram .
EEIE Dependencies
- Integration Logic
= E* Data Types
""" [C] ExistsResult
""" =l IntegrityConstraintFault
""" (] MatchesExceededLimitFault
----- (] MissingDataFault
----- = MultipleMatchingR ecordsFault
""" = ObjectMotFoundFault
""" lf] PrimaryKeyPairType
""" ] RecordNotFoundFault
""" =l UnigueConstraintFault
""" ] whidemoAddress
----- WhidemaoAddressBG
----- ] whidemoAddressContainer
----- 2] wWhidemoCustomer
----- WibidemoCustomerBG
""" [Z] WhidemoCustomerContainer
----- (2] WEIFault
#- @ Interfaces
b B Mapping
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___a. Double click new ExistsResult BO listed under Data Types
1) Status returns a Boolean value if the record is found in the database

2) Recordcount returns records found in the database for a specified query.

~Business object H T T

- |
[C] ExistsResult

[] status boolean

[8] recordcount int

L 7

13. Double click WbidemoCustomer business object listed under Data Types

vBusiness object B Es
Configuration

| Maime

| -."';"EII:E?.’*""CI.-iS""“‘:E! E'\E#ac‘mr name
| Mamespace hittp: [fwaw ibm. com¥mins prodfwebspher & f2ca fidbcwbidemocustomer  Refactor namespace
Definition S BES R =
- o
(=} WhidemoCustomer = (2] WhidemoaAddress
1 . T :
S <Click tocfilter... o <Click to filter... =
[&] pkey siring [8] addrid string
[®] Iname sfring [B] custid  string
[8] fame string [=] ity string
[8] coode string [8] zipcode string
= L a
[€] addres=obj WhidemoAddress [[——

___a. Click Application Info in the Properties tab and verify that values against jdbcasi:Ownership
and jdbcasi:KeepRelationship are true as you selected Ownership and Keep Relationship
check boxes in External Service.
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— e S a——. s e -
55 Task Flows '-.E'J Build Activities | £ Propertiss S J_xf._: Problems | [z Server Logs | ¥tk Servers |

: Element - addressobj

Description | Extensions Extension Details
Documentation

T 2 [ _
Application Info T 5 -
- . = [2] IDBCAtributeTypeMetadata m

- [2] KeepRelationship [true]

A Delete
~[8] Ownership [true]

14. Double click WbidemoAddress business object listed under Data Types

___a. Select attribute custid attribute and in the Properties tab, click Application Info. Verify that
pkey is specified against jdbcasi:ForeignKey.

vBusinessobject -~ [ o=

Refactor name
Mamespace | http: [ ibn fjdbcfwbidemoaddress Refactor namespace

«Definition

] Whidemoaddress

e alick to filter. .. >
[®] addrid string
[e]aistid siring |
[e] city string

[€] zipcode string

e P e —— = =
&8 Task Flows _f:ifa Build Activities | EE Properties £2 |21 Problems | i3] Server Logs | 47 Servers
Element - custid

Description | | Extensions Extension Details
Documentation oy e
a.ﬂn..pplica.tlion Il.rfo. - I%I JEBC el Add...
. =[] IDBCAtributeTypeMetadata
[®] columnmMame [CUSTID]
<[] Primarykey [false]

“-[B] Foreigniey [pkey]

___b. Save your work by selecting File -> Save from the top menu, or using the shortcut key sequence
Ctrl + S. Close the file.

15. Release the connection to the Derby database by using Switch Workspace

Note: Switch Workspace is a way to release the existing connection to the Derby database from the
External Service process. In the next part, you will start the WebSphere Process Server and it will need a
connection to the database to create and retrieve records. This step is necessary only because you are
using the Derby embedded driver in this exercise which supports a connection from a single JVM.

__a. From the top menu bar, select File > Switch Workspace and select the same workspace from
which you have been working.
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Part 4: Create J2C authentication alias and configure data sources

In this part you will create a J2C Authentication Alias which is required for connection to the database. You
will also create the JNDI data source name that is used by the Adapter to configure itself to the endpoint.
You will then use the WebSphere Test Environment and Component Test to test the SCA application by
retrieving several records from the CUSTOMER table in the JDBCTEST database.

1. Switch to Servers view by selecting Windows - Show View - Servers.
2. Set the authentication alias from the administrative console
__a. Inthe Servers tab in the lower-right corner pane, right click the Server and then select Start

___b. When the server status is Started, right click the Servers, and then select Administration
-2>Run Administrative console

:-'?3 Manage server profiles

Server configuration L4
Universal test client L )
Administration » Runadministrative console
Launch o » \-:‘.a'ebSp.lhere administration command assist

= = - Add and Remove Integration Solution Projects »|  Runadministrative script..

Za Task Flows: E%.Buﬂd Activities =] Properties II_B: PI"—?'% WebSphere Business Monitor Event Recording v

Ser - _State | Properties Alt+Enter
WebSphiere Process Server vZ.0 [p Started. |

__c. Log in to the administrative console by clicking the “Log in” button
__d. Click Security - Global Security

___e. On the right, expand Java Authentication and Authorization Service under the Authentication
heading.

Global security

Use this panel to configure administration 2nd the default application security policy. This security configuration applies to the security policy for all administrative

functions and is used as a default security palicy for user zpplications. Security domains can be defined to override and custemize the security policies for user
applications.

Security Configuration Wizard Security Configuration Report

Administrative security Authentication

Enable administrative security Administrative user rolels Authentication mechanisms and expiration
Administrative aroup reles
ey e ® Lrea
Administrative authentication =

Kerberos and LTPA

Application sacurity Kerberos configuration
Ensble application security ) 5WaM (depracatad): No authenticated communication batween servers

Authentication cache settings
MERWE sty Web and SIP sscurity
[ use Java 2 security to restrict application access to local resources

RMI/IIOP security
Warn if applications sre granted custom parmissions

va Authentication and Authorization Servic
Restrict access to resource authentitation data Aenes Alithenticetian andt Atthaiizetian. Semice

; [ use realm-qualified user names
User account repository

Current realm definition

Federated repositories Security domains

; g External sutherization providers
Avazilable realm definitions 7
SrRie TR mRl s o Custom properties

| Fadarsted reposi

w| | Configura... Set as current

[Apply | [Reszat |

__f. Click J2C authentication alias. It gives the list of existing aliases.
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1) Click New and enter these following values
a) User ID: Wbidemo

b) Password: Whil5Demol

Global security > JAAS - 12C authentication data > New

Specifies a list of user identities and passwords for Java{TM) 2 connector security to use.

General Properties

* Alias
|DerbyDs

* User ID
|Wbi|;|en'!n:|

* Password

Description

ﬂ . REEEt| Cancei |

___g. Click Ok and save the changes
3. Create a JDBC Provider to which is used to create data source
___a. From administrative console, click Resources - JDBC - JDBC Providers
___b. On the right, click New and choose these following values
1) Database type: Derby
2) Provider type: Derby JDBC Provider

3) Implementation type: XA data source
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Create a new JDBC Provider -

Create & new JDBC Provider

Step 1: Create new Create new JDBC provider
JDBC provider

- = Set the basic configuration walues of a JDBC provider, which
Step 2: Enter sncapsulates the speacific vandor JDBC driver implemeantation

database class path classes that are required to access the database. The wizard fills
information in the name and the description fields. but you can type differant
walues.
Step 3: Summary
Scope

[e=lls ividcellinodes:widNode

# Database e
Doty ]
#* Provider type
| Derby IDBC Provider vI

# Implementation type
[ %2 data source ~]

#* Mame
[Derby IDBC Brovider (XA)

Description

Derby embedded XA JDBC Provider. This provider
is only configurable in version 6.0.2 and later
nodes

___C. Click Next and review the summary of changes.
__d. Click Finish and save the changes.
__ 4. Create JDBC data source
___a. On the right, click Data Sources under Additional Properties heading
__b. Click New to set a data source and enter these following values
1) Data source name: Derby JDBC Driver XA DataSource
2) JNDI name: jdbc/Derby XA for JDBC
___c. Click Next to Step 2
__d. In Database specific properties for the data source, enter JDBCTEST as database name
__e. Click Next to Step 3

__f. Set the Component-managed authentication alias to the one created in the earlier section.

__ 0. Click Next and view the Summary
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Create a data source

Step 11 Enter basic
data source
information

Summary of actions:

t Q'Fifigns Valuas
datzbase speacific
properties for the Scope cellsigeellinodesignode
atad soun

et v Cata source name Crerby JDBE Driver DataSource
INDI name jdbe/Derby XA for IDBEC
Select an existing JDBEC provider Crerby JDBE Provider

Step 4z Summary Implementstion class name org.apache.derby.jdbc.EmbeddedConnectionPoolDataSource
Database name JDBCTEST
Use this data source in container i
managed persistence (CMP)
C?mp-anent-managed authentication gnoda/DarbyDS
alias
Mapping-configuration alias {nonea)
Container-managed authentication
alias toans)

_f.l Previcus l_ | Finish.}_ | Cam:el—l

__h. Click Finish and save the changes.
5. Testthe JDBC Data Source connection

___a. Check the box next to Derby JDBC Driver XA DataSource and click Test connection from the
top of the screen.

___b. You should see this success message on the top of the screen

JDBC providers

= Messages

[} The test connection operation for data source Derby JDBC Driver XA DataSource on server
serverl at node widNode was successful.

JDBEC providers > Derby IDBC Provider (XA] > Data sources > Data sources

Use this page to edit the settings of a data source that is associated with your selected JDBC provider. The data source object supplies

your application with connections for accessing the database. Learn more about this task in a2 guided activity. A guided activity provides a
list of task steps and more general information about the topic.

Preferences

| Delete | I Test connection |H Manage state...
= Y,

JNDI name : Scope : Provider 23 Description > | Category

Derby JDBC Driver XA jdbe/Derby XA for JDBC | Node=widNode Derby JDBC Provider Mew JDBC
CataSource (XA)

Datasource.
This
Datasource
type is only
configurable
in wersion
6.0.2 and
later nodes

Total 1

6. Release the connection to the Derby database by using Switch Workspace

___a. From the top menu bar, select File > Switch Workspace and select the same workspace from
which you have been working.
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Part 5: Test the application using the WebSphere test environment and
component test

This lab is using the Derby embedded database driver which allows a connection from only a single JVM
at a time. ij.bat, the External Service process, and a running Server configured with an application that
connects to the database, each are an active connection. This means you can have only one of these
active connections to the database at a time. For example, in this part, you will start the server and run
several tests creating and retrieving records from the database. You are not able to use ij.bat to view the
database, while the server is active. You need to first stop the server.

1. Inthe Servers tab in the lower-right corner pane, right click the Server and then select Start
2. Add the project to the server for the WebSphere Test Environment.
___a. Start the server by right click Server and select Start.

___b. Right click the server in the server view and select Add and remove projects ...

[ Add and Remaove Projects...
' Muonitoring L4

f1 Create tables and data sources

= view and publish the changes to the server
ELE Manage server profiles
Server configuration
Universal test cient
Administration
Launch

T v vy vy v w

= = = —— Add and Remove Integration Solution Projects
P (] X . | . 1 [
i E'E _Task Fl':‘WS__f "-f;f_B'-"ld Activities | L Pr':'_F‘EFhES__,_L:L Pl wWebSphere Business Monitor Event Recording

SE\F = . —_— .Uftate . Properties Alt+Enter
[3%) \iebSphere Process Server v7.0 i Started oo

___c. Inthe Add and Remove Projects dialog, select the JIDBCTestOutboundHierApp project from
the Available projects panel.
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__d. Click Add > to add it to the Configured projects panel. Click Finish

@ Add and Remove Projects

Add and Remove Projects =
Modify the projects that are configured on the server

Move projects to the right to configure them on the server

Available projects: Configured projects:

| I

<< Remove All

IE IDBCTestOutboundHier App

{ Finish ] l Cancel

]

Use the Test Component to test the application. The create scenario is to create a record in the

database.

___a. Right click the JDBCTestOutboundHier module and select Test->Test Component

___b. In IDBCTestOutboundHier_Test, switch to the Configurations tab, if you see
JDBCOutboundlinterface underneath Emulators, right click, and remove it. You might not see
anything under Emulators. You want to connect to and drive the real JDBCTEST database and
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not have Test Component emulate for you.

Testing Module: JDBCTestOutbound

Configurations

- Test Configuration Default Module Test
=5 Module JDBCTestOutbound
- ||_j Emulators

;;.':l com, teet A=st=ImrenuthoundInter face

= % Maonitors Add ¥
#d" <globg| Remove InterfacePartner -=
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___c. Switch back to the Events tab
1) Under Detailed Properties, choose createWhbidemoCustomerBG as the Operation.
2) Under Initial request parameters, enter these following values
a) Since custid is foreign key of pkey in Customer table, set custid to unset.

Initial request parameters:

(%) Value editor () ¥ML editar
([ £

=

- Mame I Value
=i %g createWhidemoCustomerBGInput [&hi
- verb (3l Create
= ‘?:g WhidemoCustomer = ! Customer (3Rl
- phey L[58l 100
- Iname siring [kl Smith
- fame (8l Jerry
[ coode [3hl Office
(=] addressobj = G
E—"--"i_‘:g addressobj[0] [ahi
1 addrid (56 1234
T custid shring My
i ity L8Rl Austin
I Fipcode giring {36 73756

(&) To edit values, start typing or press F2.

___d. Click 0o to continue

Events

- B F0E G
5 Invoke

___e. Inthe Choose a deployment location dialog, select the WebSphere Process Server V7.0
server. Select Finish

4. Inthe Events window you will see that Invoke has returned. Check the data in the EIS to ensure it
matches expected values.

Events

- B 3 R
= ﬁ}'{: Invoke (IDBCQuthoundInterface: createVWbidemoCustomerBG)
= "F’p- Invoke started
Bl Tnvoke (IDBCOutboundInterface:createWbidemoCustomerBG)
& Retun {(IDBCOutboundInterface:createVWbidemoCustomerBG)
E 1rvoke returned
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5. Toretrieve the record that you have just created, select the Invoke button in the top right corner
again, under Detailed Properties, select the Operation retrieveWbidemoCustomerBG. Since
Address object is a child of Customer object, you only need to enter value for Customer and that
retrieves the data for child Address object as well.

___a. Under Initial request parameters, enter a value for pkey of one of the previously created
customers. Click Continue

Configuration: IDEfT:IuIt Module Test |_1I
Module: ! IDBCTestOuthoundHier |1§
Component: |JDBCOuﬂ:oundInterface1 |vi
Interface: |JDBCDuﬂJoundInterfacel |:]
Operation: | retrieve\WbidemoCustomerBG |_1I

Initial request parameters:
(&3 value editor 3 XML editor

I = &l
Marmie | Value [S|
l % retrievebidemoCustomerBGInput [F8 |
S0 verb 3kl Create
l:.il-%g WhidemaCustomer * [EEl
L pkey {(2H 100
A Iname [IFL]
AL frame (=8
- ecode T
=[] addressabi * i
=-F addressobi[d] =
- addrid =kl
0 custid 3]
el ity (=8
-+{[J zipcode 11

| () To edit values, start typing or press F2. |

___b. Upon return, the values matching the ID specified should be displayed in the Return parameters.
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EJB: B
E

Mame | Type | value
= By retrieveWbidemoCustomerBGOutput VWhidemoCustomerBG v
T verb string »/
EI%; WhidemoCustomer WhidemoCustomer v
..... = pkey string ' 100
..... T Iname string + Smith
..... 1 fhame string + Jerry
..... [ coode string + Office
=-[=] addressobj WhidemoAddress[] v
=5 addressobi[o] WhidemoAddress v
[ addrid string v 1234
..... [ custid string + 100
..... I dty string + Austin
. 2 zipcode string + TE75E

6. To test aretrieveAll, select the Invoke button, then under Detailed Properties, select the Operation
retrieveAllWbidemoCustomerBG

___a. Set everything to <unset> by highlighting all the fields and selecting the <unset> from the drop
down menu.

___b. Click Continue.

Initial request parameters;
%) Value editor ) XML editor

P e ’,E| 8
Name I Type | Value |
= %: retrieveallVbidemoCustomerBGInput WihidemoCustomerEG =11 I
L verb verb<sming= 58l Create

= WhidemoCustomer * WhidemoCustomer L&l

i pkay ! etving -1

- Iname airing 1]

7 fname etring
I crode siring By |
=[] addressobi * Vitbidericaddress]] i [
%g ‘addressobj[0] Whidemaoaddress H [
|
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___¢. Upon return, the values for Customer table existing in the database should be displayed
including values from the Address table.

___d. View the return parameters box to check for the returned records scrolling as needed.

7. To test whether records exist or not, select the Invoke button, then under Detailed Properties,
select the Operation existsWbidemoCustomerBG. This returns the status of the query and
numbers of records based on the input criteria.

___a. Under Initial request parameters, enter a value for pkey of one of the previously created
customers.

___b. Set Iname, fname, and ccode to <unset> by clicking on the field and selecting the <unset> option
from the drop down menu. Click Continue.

Initial request parameters:

¥ Value editor () XML editor

Name Value

| e existeWhidemoCustomerBGInpy, ., | 1)
L werb (3l Create

= L‘_r':g WhidemaCustomer * 1|
I pkey a8l 500

T Iname He

00 fname 1|

7 ceode My

=-[2] addressobj * e

% %:,, addressaobil] Hy

___¢. Upon return, the result should be displayed with Boolean value whether a particular record exists
in the database or not. RecordCount returns the number of records found in the database for the

input criteria.
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Return parameters:

E:lfe = O
| Mame Value
= %= existsluliebmCust. .. v
1 status v frue
[ recordcount v 1

___d. View the return parameters with EIS data to ensure the count is correct.

8. User can also query records based on any attribute values and not just based on primary key
attributes. Select the Invoke button, then under Detailed Properties, select the Operation
existsWbidemoCustomerBG.

___a. Under Initial request parameters, enter value for any attribute created customers.

Initial request parameters;
) Value editor () XML editor

ll’
10

MName Value |
= %g exists\WbidemoCustomerBGInput (38
[ verb (58l Create
= %g WhidemoCustomer = [ER
AL phey 1]
7 Iname {85 Johnson
2 fame Be
[ ceade b
= [3] addressobi = g
- "Eg addressobij[0] By

(1) To edit values, start typing or press F2.

___b. Set remaining attributes to <unset> by clicking on the field and selecting the <unset> option from
the drop down menu. Click Continue.
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___¢. Upon return, the result should be displayed with Boolean value whether a particular record exists

in the database or not. RecordCount returns the number of records found in the database for the
input criteria.

Return parameters:

EB: B8
| Mame Type Value
= %g existsJulieibmCust. ., W
[ status o
[ recordeount v

___d. View the return parameters with EIS data to ensure the count is correct.

9. Exit the Test Component panel, remove the JDBCTestOutboundHier project from the server, and
stop the server.
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What you did in this exercise

< In this exercise, you learned how to create a multiple cardinality business objects Hierarchy using
External Service Wizard, instead of editing the parent and child Business Objects using Business
Object Editor.
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Task: Adding remote server to the WebSphere Integration Developer test

environment

This task describes how to add a remote server to the WebSphere Integration Developer Test environment.
This example uses a z/OS machine.

1. Define a new remote server to WebSphere Integration Developer.

___a. Right click the background of the Servers view to access the pop-up menu.

___b. Select New - Server.

Build Activities | Properties | Problems | i Servers 22 5
Server Stakus
Websphere Process Server v6.1 Et@ Stopped

___c. Inthe New Server dialog, specify the remote server’s host name, <HOSTNAME>.

Mew ¥ [ Server [:

___d. Ensure that the appropriate server type, ‘WebSphere Process V7.0 Server’ or ‘WebSphere
ESB V7.0 Server’, is highlighted in the server type list

___e. Click Next.

2010 May, 03

@New Server @@

Define a New Server -
Choose the type of server to create

Server's host name: | mvsi.rip.ralesigh.ibm, com| w

Select the server type:

M
m
m

== 1BM
WebSphere ESB v6. 1 Server
ﬁ WebSphere Express w5, 1 Server
WebSphere Process vé, 1 Server
E‘:‘ WebSphere v5 Server Attach
ﬁ WebSphere v5. 1 Server
WebSphere v56.0 Server
WebSphere v&. 1 Server

+-[Z= Other

View By: | Vendor V
Description: Runs service projects on the WebSphere Process ve. 1 Server.

Server runtime: | \WebSphere Process Server vé, 1 v Installed Runtimes...

2) Mext = ] [ Finish l ’ Cancel
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__f. On the WebSphere Server Settings page, leave the radio button for SOAP selected, changing the
SOAP connector port to the correct setting (<SOAP_PORT>). If security is on in your server,
check the box for ‘Security is enabled on this server’ and input <USERID> for userID and

<PASSWORD?> for the password.

€0 Mew Server

WebSphere Server Settings

Input settings for the new WebSphere server,

Server connection type and admin port

() RMI (Designed to improve communication with the server)

(23 50AP (Designed ko be more firevall compatible)

SO0P conneckor port: | 5830

Security is enabled on this server

Current active authentication settings:

User [D; szadmin
Password: [TITTY
Server name: sssr01d

Server bype
(=) BASE, Express or unmanaged Mebwork Deployment server

() Network Deployment server

Click this button ko detect the server bype,

S

< Back ” Mexk = ”

Einish ] [ Cancel

___g. Click Finish.
___h. The new server should be seen in the Server view.

Build Activities | Properties | Problems | 415 Servers 22

Server Status
wWebSphere Process Server wb,1 = Stopped
wehSphere Process 6.1 Server @ mvsiood.rtp raleigh.bm.com B Stopped

support starting remote servers from the Server View.

B =8
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2. Start the remote server if it is not already started. WebSphere Integration Developer does not

___a. From a command prompt, telnet to the remote system if needed:
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‘telnet <HOSTNAME> <TELNET_PORT>’
User ID : <USERID>
Password : <PASSWORD>
___b. Navigate to the bin directory for the profile being used:
cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin
___¢. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

__d. Wait for status message indicating server has started:

ADMU32001: Server launched. Waiting for initialization status

ADMU30001: Server sssr0l1 open for e-business; process id iIs 0000012000000002
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